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Disclaimer  
 

Interactive Individual Identification 
System - Contour version 

 
 
I3S Contour is free software; you can redistribute it and/or modify it under the terms of 
the GNU General Public License, version 2 or any later version published by the Free 
Software Foundation. 
 
This manual is released under the terms of the GNU Free Documentation License, 
version 1.1 or any later version published by the Free Software Foundation. 
 
This program is distributed in the hope that it will be useful, but  
WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY 
or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General Public License for 
more details. 
 
You should have received a copy of the GNU General Public License and GNU Free 
Documentation License along with the distribution (COPYING GPL v2.txt and 
COPYING.DOC.txt) If one of these files is missing, write to the Free Software 
Foundation, Inc., 59 Temple Place - Suite 330, Boston, MA 02111-1307, USA. 
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1 Introduction to I
3
S Contour 

1.1 What is I
3
S Contour? 

I
3
S is an acronym of Interactive Individual Identification System. I

3
S Contour is an extension of the 

I
3
S system using the contour of e.g. the tail, dorsal fins or lining along the side. This name explains 

most of I
3
S Contour’s functionality. First, we will focus on the interactive part. I

3
S Contour requires 

user interaction and is meant to support and not to replace the researcher. Initially, you have to point 
out the relevant part of the contour of the unknown individual animal. I

3
S Contour has an semi-

automatic tracing algorithm which tries to find the optimal contour between the points selected by 
you. In the next step, I

3
S Contour assists you in the tedious task of matching animals for identification 

purposes. It automatically matches an annotated image of an unknown animal with all annotated 
images in the identification database and shows a ranked list of images. However, you will always be 
responsible for making the final match between the unknown image and an image from the 
identification database. Please note that we distinguish between your database with all images taken 
and the identification database. The identification database contains only the best images of known 
individuals and preferably 3 to 5 of each individual.   
 
I
3
S Contour is the third release in a series of related software tools. The first was I

3
S (now referred to 

as I
3
S Classic). This package is based on annotation of the spot centers and is used for animals with 

lots of similarly shaped spots such as whale sharks. The second package was named I
3
S Manta. I

3
S 

Manta focuses on animals with less spots and more variation. Instead of annotating the centers only, 
spots are annotated by the closest fitting ellipse around each spot, in this way taking spot size and 
shape into account.  
 
We refer in the remainder of this manual to I

3
S Contour as I

3
S.  

1.2 The algorithm 

To help recognize individual characteristics like the tail flukes of whales, I
3
S first traces and extracts 

the fluke contours of the unknown tail. The image should be taken ideally perpendicular to the line of 
sight and no more than 30 degrees off that line. The algorithm for automatic tracing and extracting 
the contour is based on the algorithm as described by Eric N. Mortensen and William A. Barrett in 
their paper on ‘Intelligent Scissors for Image Composition’ [1]. 
 
For contour tracing, the goal is to find the optimal path between a start node and a set of goal nodes. 
This means finding the globally optimal path from a start pixel to a goal pixel where the pixels 
represent nodes and edges are created between each pixel and its 8 neighbors. Optimality is defined 
as the minimum cumulative cost path from a start pixel to a goal pixel where the cumulative cost of a 
path is the sum of the local edge (or link) costs along the path. 
 
PLEASE DO NOT accept the results from the automatic contour tracing too easily. It is essential that 
the contour is an exact fit to the image. The automatic tracing algorithm frequently results in small 
errors, especially if the body part overlaps with e.g. the waves or the horizon. In this case you should 
take smaller steps or use the manual algorithm. 
 
The next step is to match the contour with all identified contours in the identification database. The 
contour matching software is based on the ideas from the EUROPHLUKES project (for more 
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information see [2] and [3]) developed by the Center for Mathematics and Computer Science in 
Amsterdam (CWI). Version 3.0 contains a completely new implementation based on their ideas. 
 
To be able to compare two contours it is essential to transform them into a single common space. 
This is done in a number of consecutive steps: 

1. Translation and rotation. The entire contour is translated such that the start of the contour has 
coordinates (0,0). Simultaneously, the contour is rotated to start and end at the x-axis  
(Figure 1-1a, b and c). 

2. Scaling. The contour is scaled to have the last point on the contour end at (500,0)  
(Figure 1-1d). 

3. Histogram. To allow for fast comparison the area below each line piece in the contour is 
discretized into 500 bins. Each bin represents the total area below the contour in this bin  
(Figure 1-1e). 

 

 
(a) The original image. Only the left fluke is annotated. 

 
 

 
(b) The extracted contour pixels of the left fluke. 
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(c) The contour after translation and rotation. 

 

 
(d) The contour after scaling. 

 

 
(e) The final histogram for fast comparison. 

 

Figure 1-1: Transforming the contour into a normalized space. 

 
Comparing two histograms is as simple as comparing the 500 bins one by one and calculating the 
total absolute difference. The more they overlap the better the match (a perfect match will result in 
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score 0). This simple operation can be carried out very fast. However, in practice various 
circumstances will make the straightforward comparison fail. The main reasons are: 
 

1. The body part is not photographed from an exact perpendicular angle. Tilt for example, may 
influence the amplitude of the contour function.  

2. The body part, especially the tail, is not a rigid shape and subject to various distortions. 
 
 
To find an optimal match between two contours, one of the contours is simultaneously rotated, 
scaled and translated in a brute force approach. In pseudo-code the algorithm looks like this: 
 
 // Comparing contour C1 and C2 

 For all angles between -5
o
 and +5

o
 do 

    Rotate C1 

    For all scales between 25% and 400% of the original size do 

       Scale C1 

       For all shifts between 25 bins to the left and 25 bins to 

                    the right do 

               Shift C1 

               score = compare(C1, C2) 

               If score < bestScore then  // lower score is better match 

                  bestScore = score 

               Endif 

            Endfor 

         Endfor 

      Endfor 

 
To speed-up the algorithm, the brute force approach is first carried out with relatively large steps in 
all three for-loops. Around the best angle, scale and translation found in this coarse approach, the 
algorithm is repeated but now with much finer steps. The best match found in the fine approach is 
ultimately the final score between two contours. 
 
In case of a whale tail with two fluke contours, the algorithm is repeated for the other fluke and the 
average of the two flukes is returned for the entire image. 
 
I
3
S finally gives a ranked list of potential matches with images from the identification database. These 

images can be shown so a visual comparison can be made. You always have to make the final 
decision in the comparison. The better the match, the lower the score. The best possible score is 
zero or close to zero. 

1.3 I3S Version numbering 

Version numbers are related to I
3
S Classic and I

3
S Manta. So even though I

3
S Contour is new, the 

current version is version 3.0. Most of the underlying software for metadata and user interfacing is an 
update of existing software from I

3
S Manta v2.1, hence the v3.0 version of I

3
S Contour. 

1.4 I3S Updates 

I
3
S will automatically check for updates and new releases. This feature will be implemented in all I

3
S 

software packages in version 3.0 and higher. Every 30 days, upon start-up of I
3
S, it will check for 
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updates. If an update is available, it will ask you if it should download and install a new version. After 
each update I

3
S will ask if you want to see the release notes on the website. 

 

 

Figure 1-2 Update check. 

Please note that downloading and installing updates only works in Windows Vista or Windows 7 if 
User Account Control is turned off and if you have sufficient rights. UAC prevents Java to copy files 

to protected locations such as C:\Program Files even if you have administrator rights. You can 

manually set this parameter via the Control Panel of your computer.  

1.5 Reading this document 

In this document all file name, directory names and shell commands are written using the font  

Courier New. All names relating to a part of the I
3
S user interface, such as button names or menu 

options, are boxed.  

1.6 Bug reports, comments and requests 

Please send all bugs, comments and questions to i3s@reijns.com. In case of a bug, describe clearly 
how we can reproduce the bug ourselves. If possible provide us with all relevant data such as 
images and fgp-files. We will always treat your data as confidential. Data will not be distributed to 
others without your explicit consent.  
 

An error log file will be written in the _ErrorLogs directory in your data directory when internal 

errors are reported by the software. This file (or files) can also be sent to the I
3
S team along with any 

bug report. 
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2 Installation of I
3
S Contour 

2.1 System requirements 

This version of I
3
S requires a Windows 32-bits or 64-bits operation system (XP/Vista/Windows7). The 

software is developed using Java 1.6/1.7 and C++ (MS Visual C++ 2008 Express edition). Both Java 
and most of the C++ code are platform independent and it should therefore be relatively simple to 
port it to other platforms such as Linux or Mac OS.  
 
Hardware requirements are at least 1024 MB of memory (preferably 2048 MB or more), and a 1 GHz 
CPU or faster. Increase of the identification database to hundreds of images will increase the minimal 
requirements on CPU speed but will have a limited impact on the memory requirements. Comparison 
is linear in computational requirements, i.e. an identification database with twice the number of 
individuals will require twice the time to compare. 

2.2 Software and data requirements 

Because the main program is developed in Java, the Java Run-time Environment (JRE) is required. 
This distribution will only work with JRE version 1.8 or higher! The JRE 8 (or higher) can be 
downloaded for free from the Java website (http://www.java.com/getjava) or the Oracle website 
(http://www.oracle.com/technetwork/java/javase/downloads/index.html).  
 
Note: I

3
S currently only works with the 32-bits version of the JRE. I

3
S has been developed on a 64-

bits version of Windows 7, however with a 32 bits JRE. If a 64-bit JRE is installed I
3
S will report an 

error while loading a dll. 
 

I
3
S supports both JPEG (extension .jpg) and GIF (extension .gif) images. Support of other image 

types is currently note foreseen as all known digital cameras can store images as JPEG. 

2.3 Installation 

Make sure you have administrator rights and turn User Account Control off. UAC prevents the proper 
installation of the Windows environment variables. 
 

Run the file I3SC_v3.0_Setup.exe. If your current Java version is not sufficient you will be notified 

and installation terminates. It is required to install the Java Runtime Environment 1.7.0 or higher first.  
 
Apart from some information about the GNU-license, the installation consists of the following steps: 
1. Choosing the home directory where to install the program. Default will be in the directory 

C:\Program files\I3SC or C:\Program Files (x86)\I3SC in case of a 64-bits OS. 

2. Choosing whether you want to store an example data directory with image and fingerprint files.  
3. You can indicate if you want I

3
S to create a folder in the Start menu folder.  

4. Finally, you can select some additional tasks: 
a. Creating a desktop item. 
b. Copy tutorial examples in the installation directory. 
c. Copy the source code. Only if you are interested in using or changing the source code 

you need to check this item. 
5. If you selected to copy the tutorial images, you will be asked for the location. 

http://www.java.com/getjava
http://www.oracle.com/technetwork/java/javase/downloads/index.html
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Because an environment variable has been added you are asked if you want to restart the computer 
now or later. I

3
S will not work properly until you restart the computer or logout and login again. 

 
If you want to install I

3
S under another account this is possible. At start-up the application will search 

for the I3SC_INSTALL environment variable which has as value the directory where I
3
S is installed. 

The default location is C:\Program Files (x86)\I3SC. The installer creates this variable in the 

HKEY_LOCAL_MACHINE section of the registry which means that it is available for all users. If this 

variable is not found, the application terminates. At the first start-up of another user ust select an 
existing database or create a new database. 

2.4 Uninstall 

You can uninstall I
3
S in two simple steps: 

1. Uninstall I
3
S, using the entry in the start menu folder.  

 

Figure 2-1 Uninstall via start menu. 

2. Optionally you can also uninstall the Java Runtime Environment (JRE). In general it is not a good 
idea to uninstall JRE without replacing it for a newer version because other programs may 
depend on it. However, if you still want to uninstall JRE use the standard procedure: Select 
Programs and Features  in the Control Panel. Then select the appropriate item from the list and 
click on the Add/Remove button.  

2.5 Tutorials 

Examples are shown in our instruction videos. These video’s are available online at our website 
http://www.reijns.com/i3s/download/I3S_download.html.  
 

 

Figure 2-2 I3S Contour Start menu 

The following tutorial topics are available: 
1. Easy annotation. 
2. Difficult annotation. 
3. Search. 
4. Using metadata. 
5. Editing metadata. 
6. Adding a new database. 

http://www.reijns.com/i3s/download/I3S_download.html
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3 Data management 

3.1 Introduction 

I
3
S compares unknown images with an identification database consisting of a collection of image-

fingerprint pairs.  In this document, with identification database a structured directory containing the 
collection of all known images used for reference by I

3
S is meant. Possibly you will have another 

database or collection of unknown images, but that is considered an entirely different database. 
 
A fingerprint file containing all information added in the annotation process accompanies each image 
file. Always treat these images as an inseparable pair. If you move one of the files manually to 
another directory you should always move the other file along. 
 
Previous versions of I

3
S only allowed one identification database. At installation the user had to 

select a specific directory where the data was stored. Multiple identification databases (either other 
types of animals or other locations) where not supported and resulted in the need to rename and 
swap database directories.  
 
I
3
S Contour v3.0 allows you as many identification databases you need. The locations of data 

directories are stored at an individual level (specific: in the registry in HKEY_CURRENT_USER), so it is 

possible to have multiple users using the same pc or laptop and manage their own databases as well 
as manage shared databases. 
 

All database management is found under the menu item Database, see paragraph 4.1.3 for details 

on their use. 

3.2 Database type 

Currently, I
3
S Contour supports three database types: 

1. Whale tail. Choose this option when you have two contours simultaneously visible. 
2. Dorsal fin. This option is suitable for body parts which have a left and a right view such as a 

dorsal fin. When choosing this type the metadata elements will automatically get a field 
named ‘view’ with possible values ‘left’ and ‘right’. For each image it must be clear which side 
is viewed because when comparing a left and a right view image the contour has to be 
mirrored. 

3. Generic. The last option is suitable for any animal with a single contour per image which can 
only be viewed from a single side, such as the contour between the dark and the light half of 
a white shark. 

3.3 I3S management tools 

I
3
S offers the following tools for data management: 

 
1.  Search in database Compare an annotated image against the entire identification 

database and show a ranked list of results. The lower the 
score, the better the match. 
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2.  Insert in database Add an annotated image to the identification database. Either 
add it to an existing individual or insert it as the first image of a 
new individual. 

3.  Reload database In case you have manually added or removed files to the 
identification database directory you can reload the current 
database to incorporate the changes. 

4.  Change database Load another database from the list of known databases. 

5.  New database Start a new identification database and add it to the list of 
known databases. 

6.  Edit database list Remove a directory from the list of known identification 
databases or add a directory. The latter is used to add an 
existing identification database. 

7.  Edit metadata Edit the metadata structure of the current identification 
database.  

3.4 The database directory 

All data in an identification database is structured by means of a directory tree. Images are stored in 
a separate subdirectory for each individual in the identification database. Each image is described by 

its contour(s) and by means of metadata fields stored in the fingerprint file with extension .fgp. In 

older versions of I
3
S, the sex and various views where stored by means of subdirectories under the 

subdirectory for the individual. Starting with v3.0, sex and views can be covered by the metadata 
structure. You are  however required to define this yourself.  
 
The top-level directory of an identification database contains for all known individuals a 

corresponding directory, the file metadata.xml, a directory named _ErrorLogs for error reports by 

the software, and an optional directory _SearchResults with the outcome of the various searches.  
 

For example: 
 

Directory Description 
C:\I3S\WhaleData Top-level directory. It contains directories for the individuals 

Jimmy, Ronald, George and Bill and the directory 

_ErrorLogs. 

C:\I3S\WhaleData\Jimmy This subdirectory contains image and fingerprint files 

Jimmy001.jpg, Jimmy001.fgp, Jimmy002.jpg, 

Jimmy002.fgp. 

C:\I3S\WhaleData\Ronald This subdirectory contains image and fingerprint files 

Ronald.jpg, Ronald.fgp, Ronald2.jpg, 

Ronald2.fgp, DSC_00261.jpg and DSC_00261.fgp. 

The naming of the latter two files is not very useful as it does 
not refer to the individual Ronald. When it shows up in the 
result list it will not be clear which individual is meant. 
However, it is not illegal. 
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The subdirectories for individuals should only contain image files and fingerprint files (extension 

.fgp). Other file types are ignored. The image files should be of type JPEG (extension .jpg or 

.jpeg) or GIF (extension .gif). Each fingerprint file corresponds with the identically named image 

file (apart from the extension). A fingerprint file contains all the contour and extra information of the 
corresponding image file. The sample identification database provided with the distribution contains 
several individual humpbacks (i.e. subdirectories).  
 
At start-up, I

3
S looks up the list of known databases. In case the list contains only one, this database 

is loaded directly. If the list is empty, you have to create a new identification database first or select 
an existing database. In case the list contains more than one, you are asked to select a database. 
After selection, the application starts to parse all the fingerprint files in the corresponding individual 
subdirectories. All fingerprint files are stored in memory for quick future reference during execution of 
search tasks. Since the fingerprint files are quite small (usually a few kilobytes) the memory use of 
the database will be limited. 

3.5  Metadata 

Each identification database has its own metadata definition. For example it is possible to define 
metadata fields to indicate length, size, sex, scars, or whatever you want to define for an individual. 
When searching the identification database, it is possible to search on the metadata as well. The 

exact metadata definition is stored in the file metadata.xml stored at the top of a database 

directory. It is strongly advised not to edit this file manually but to use the graphical interface provided 
by I

3
S for this purpose. 

 

I
3
S currently supports four types of metadata fields: number, smallmediumlarge, yesno and 

Custom. The number format will accept any number such as 0, 12, 4.2 and -5. The type 

smallmediumlarge is a variable with three possible values (small, medium and large). Analogous, 

the yesno type is a Boolean variable with values yes or no. Custom lets you define a discrete set of 

values yourself. 
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4 The I
3
S user interface 

This chapter will address the possibilities of the I
3
S user interface. First, the menu bar and toolbar are 

described. Next, the interaction with the annotation panel is discussed. 

4.1 The menu bar 

I
3
S offers a standard Windows look & feel menu-based interface to perform most operations. In the 

paragraphs below, the current five menu items will be briefly discussed. An overview of the title and 
menu bar is shown in Figure 4-1. The title shows the application name version and some details 
about the database: name, type and between brackets the number of fingerprints (not individuals) in 
the database. 
 

 

Figure 4-1: The I
3
S menu bar. 

4.1.1 The File menu 

This is the main I
3
S menu. Figure 4-2 shows the various operations, which are discussed below: 

 

 

Figure 4-2: the file menu. 

 

 Open image (shortcut CTRL+O). It will open a window to choose an image file. The supported 

image types are JPEG and GIF. The starting directory will be the value in the environment 

variable I3SC_DATA. If an image file has a corresponding fingerprint file (i.e. the same name but 

extension .fgp) a whale tail logo is shown, a standard image logo otherwise. The logos are 

shown below: 

  (with .fgp)   (without .fgp) 

 

 Save fingerprint (shortcut CTRL+S). If you have been tracing a contour in an image this 

operation will write a fingerprint file in the same directory as the corresponding image together 

with any metadata. Apart from the extension, which is .fgp, the name will be identical to the 

name of the image file. 
 

 Close image. It closes the image in the main window. If you have unsaved data I
3
S will prompt 

you whether you want to save the data first. 
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 Print image (shortcut CTRL+P). It will print the current image including comments (see 

paragraph 4.2). 
 

 Exit (shortcut CTRL+X). This operation will close all windows. In case of unsaved data I
3
S will 

prompt you whether you want to save the data first. 

4.1.2 The Edit Menu 

 

 

Figure 4-3: The edit menu. 

 

 Undo and Redo are completely analogous to standard Windows functionality. The last 500 edit 

actions are kept in memory (Shortcuts: CTRL+Z and CTRL+R). 

4.1.3 The Database menu 

 

Figure 4-4: The database menu. 

 Search in database will compare the current image with the rest of the identification database. 

See Chapter 5 for details. 
 

 Insert in database In case of a loaded and annotated image, selecting this operation will allow 

you to add a new animal (i.e. a new subdirectory) to the identification database. This operation 
pops up a new window first that will prompt you for the name of the new animal. Selection of the 

checkbox Rename file will allow you to change the name of the image (note: not only the name of 

the animal which is determined by the subdirectory name, add a number, date, etc. as well). 
Since the results of a search operation only shows the names of the best matching images, it 
makes sense to make sure all filenames clearly indicate the name of the individual animal. By 

pressing Ok the image and its fingerprint file are copied (not moved) to the appropriate directory 

in the identification database. The figure below shows an example. If the file has been renamed, 
you are asked whether the original file needs to be renamed as well. 
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Figure 4-5: Insertion in the identification database. 

 Reload database If the identification database has been changed, i.e. fingerprint files have been 

manually added or removed using e.g. Windows explorer, this operation will reload the entire 
database. You do not have to call this operation after insertion of a new animal in the 
identification database. In this case, I

3
S will reload the database automatically. 

 

 

Figure 4-6: Changing the database. 

 

 Change database If you have multiple identification databases it is possible to load another 

identification database without exiting the application. This menu option will offer you a list to 

choose the database. Choosing the current database is identical to Reload database. Before 

changing the database, open files are closed and/or you are asked whether to save first. 
 

 New database If you want to create a new identification database choose this menu option. First, 

you are asked to select a new directory, either by typing it in at the text field Folder name or 

selecting the Create new folder button. Figure 4-7 shows the window. When you nevertheless 

choose an existing directory, the application will ask to create a new directory within the chosen 
one. After selecting a new directory, you are offered a window to specify the database (e.g. type, 
metadata). This window is almost identical to Figure 4-11. 



I
3
S Contour Manual, v3.0 September 2011  

 
 
 
 
 

18 

 

 

Figure 4-7: The first step in creating a new database, directory selection. 

 

Figure 4-8: Setting-up the database. 

 

   

Figure 4-9: The three database types: ‘whale tail’, ‘dorsal fin’ and ‘generic’. 
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The most important selection to make is the database type. Three options are available: 
 
1. Whale tail. Choose this option when you have two contours per individual. 

 
2. Dorsal fin. This option is suitable for body parts which have a left and a right view such as a 

dorsal fin. When choosing this type the metadata elements will automatically get a field 
named ‘view’ with possible values ‘left’ and ‘right’. For each image it must be clear which side 
is viewed because when comparing a left and a right view image the contour must be 
mirrored. 

 
3. Generic. The last option is suitable for any animal with a single contour per image which can 

only be viewed from a single side, such as the contour between the dark and the light half of 
a white shark. This contour, unlike dorsal contours, will not be mirrored during comparison. Of 
course, you can have left and right side images of a white shark or other animal. With a 
metadata field “view” you can distinguish between multiple views. 

 
Other variables to specify are the database name. Type in a concise name as it is also shown in 
the top of the main application window. ‘Start hint’ and ‘Finish hint’ is the text shown in the 
instruction field during annotation (see also paragraph 4.2). The start hint is shown before the 
starting point is selected, and should indicate how to select the starting point. The finish hint is 
shown after the starting point is selected and it should give instructions where to end. Further, it 
is possible to add a number of metadata fields to the identification database.  
 

 

Figure 4-10: The window to edit the database list. 

 

 Edit database list If you want to remove an old database from the list of known databases or 

add an existing database directory you can use this option. Figure 4-10 shows the 

corresponding window. Remove deletes the selected directory from the list. Add lets you 

select an existing directory and adds it to the list without checking whether it is a valid 
identification database directory (this will happen when the database is actually loaded). 
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Figure 4-11: The window to edit the metadata. 

 
 

 Edit metadata This last option allows to edit the metadata fields for the current database. 

Figure 4-11 shows the window. 
 

The red numbers 1 to 5 indicate some important aspects of this window: 
1. The database type. Please note that this field is ‘greyed out’. The database type can only 

be established at creation of the database and cannot be altered afterwards. 
2. The field database name defines the name which is shown in the title of the application. 

Press the button  to alter the name. When editing a field, it is not possible to select 

other buttons, except Cancel or  again to save the result. 

3. Start hint and finish hint are texts which are shown during annotation to help users to 
annotate properly. 

4. Use the left column of buttons to edit the names of the metadata elements. When the 
database type is ‘dorsal fin’ the element ‘view’ with values ‘left’ and ‘right’ is obliged and 
as a consequence, this element cannot be edited or removed. 

5. Press the button  to remove the field. Press the button  to edit the names of the 
custom field type. This button is only available for type custom as only this type allows 
you to define a list of possible values. When pressing this button the window is enlarged 
to show the fields to edit the possible values. Figure 4-12 (left) shows the result after 

pressing  for element ‘edit’. All other elements are greyed out, except for Cancel and 

the buttons to edit the fields for the custom element. The minimum number of values must 

be two, the maximum is limited to 10. Close editor stores the list of values (if valid) and 

returns the window to the previous state. 
 

1 

2 

3 

4 5 
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Figure 4-12: The enlarged metadata edit window (left) and the Options window (right). 

4.1.4 The Tools menu 

Options will pop-up the window shown in Figure 4-12 (right).  

 

The first part Logging results of the options window concerns the automated logging of the searches 

performed. If logging is on, the outcome of each search will be written to a file in the database 

directory (subdirectory _SearchResults). 

 

The naming of the file is SearchResults__<date>_<time>.log. For example, a search on the 

second of July 2010, at the time of 17:22:10 will be written to the file named 

SearchResults__20100702_172210.log. The content of the log file is identical to the results in 

the search results window. Each line contains a filename and the score separated by tabs. Excel can 
process this format. 
 

The second part Show results can be used to indicate whether you are interested in the top 50 of 

best matches or the entire identification database. This choice will affect both the logging and the 
search results window. 
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Next you can choose whether you want to get a warning when you drag your mouse during contour 
annotation. I

3
S requires you to keep the mouse completely still when clicking a point on the contour. 

If you have once chosen never to be bothered ever again you can correct this here. 
 
The fourth part allows you to choose the interaction with respect to updates. When choosing 

Automatically check for updates the software will check periodically without interaction. Only when an 

update is found you will be asked whether you want to install. Ask to check for updates will make 

sure I
3
S gets permission before an update check. Never check for updates will make sure I

3
S never 

bothers you about updates, unless you manually choose Check for updates from the help menu.  

 

The last part named Color settings allows you to select which colors to use for the annotation 

elements. This can be particularly helpful if the species under study happens to show colors similar 
to the default colors used or if you are color-blind. 

4.1.5 The Help menu 

 

 

Figure 4-13: The Help menu. 

 Open manual will start your default pdf reader and open the manual. 

 

 Check for updates… will check if there are updates. If an update is available you will be asked 

only once to install at the next start-up of I
3
S, even if update checking is disabled. For successful 

installation Windows User Account Control has to be turned off. 
 

 Go to the I3S website will open your default web browser and show the I
3
S website. 

 

 About I3S… shows a window with information on version number, authors, copyright and contact 

details.  

4.2 The tool bar 

Below the menu bar I
3
S shows a tool bar, which offers short cuts to functions described in the 

previous paragraphs and some new functions. An overview of the tool bar is shown in Figure 4-14. 
 

 

Figure 4-14: The tool bar. 
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The table below describes the various items in detail. 
 

 
Open file. Button for the menu option described in paragraph 4.1.1. 

 
Save file. Button for the menu option described in paragraph 4.1.1. 

 
Print file. Button for the menu option described in paragraph 4.1.1. 

 
Search. Button for database search described in Chapter 5. A keyboard 

shortcut is ALT+S. 

 
Edit the information field. Each fingerprint file contains an information field. 
Upon pressing the button, a metadata editor is opened (see paragraph 5.1 
for details). 

 
Show the normalized contour and corresponding histogram of the 
contour(s). 

, ,  
Controls for zoom. Pressing the plus will zoom in on the image. If the 
enlarged image does not fit the screen two sliders will appear. The mouse 
wheel can also be used for zooming. The minus will zoom out. The zoom 
factor is displayed right of the minus. The maximum allowed zoom factor is 
1000%. 

 or  
Change indicator. If the annotation has changed the button becomes 
yellow until the fingerprint is saved. 

 
A field, which will show instructions during annotation. The field is larger in 
the application. 

 
In case of automatic contour annotation between user defined control 
points this button is yellow. Automatic contour tracing is the default. 

 
If automatic tracing fails pressing this button will switch to manual 
annotation. In this case straight lines are drawn between subsequent 
control points. 

 and  
An annotation may consist of two contours (flukes). The button, which is 
yellow, indicates which fluke is currently available for annotation. In case 
of dorsal fin or generic database types these buttons are not available. 
 

,   
 
 

A contour can be active or final. An active contour is not annotated or is 
being annotated. When finished you are required to mark this by pressing 
final. 
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Only in case of database type ‘whale tail’ there are two contours per 
image, most likely flukes of a whale tail. Only in this case it may happen 
that only one of the contours is of sufficient quality. If a fluke is of very poor 
quality and not suitable for annotation, you should press N/A. When a 
fluke is already annotated, choosing for not available will not discard your 
work. The contour will be shown in a lighter color to indicate it is not used. 
If you reconsider you can make it active or final again without re-
annotation. 
 
If the database type is not ‘whale tail’, this button will not be available. 

4.3 Contour annotation 

A contour is annotated by clicking with the left mouse button along the contour. Before and after the 
first interaction the application will show a different help text how to annotate. The software will follow 
the contour automatically between two selected control points. Clicking the right mouse button will 
remove the last control point and the corresponding contour part. For details on the annotation you 
are referred to the tutorial videos available on our website on the download section. of the website. 
To prevent problems with video codecs the videos are made available as executables. 
 
The better the contour quality the better the results. In case the automatic tracking gives (even small) 
errors, make the distance between the control points smaller or select manual tracking and apply it in 
very small steps to get around difficult parts.  
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5 Searching and using metadata 
This chapter discusses the search process in more detail. First, the options to add metadata are 
discussed. Next, the search process is described in detail. 

5.1 Adding metadata 

I
3
S allows you to add metadata to an image. Metadata is additional information, which describes the 

individual, or perhaps the conditions in which the image was taken. If you press the  button in the 
toolbar a new window pops up. The window is shown in Figure 5-1. 
 
The upper text field allows you to store plain text. There is no limitation to its length. If no text has 
been added yet, the string ‘Empty comment field’ is shown.  
 

The Metadata elements field below allows for a more structured input. Four types of fields are 

available: numeric, general size with three possible values (small, medium, large), Boolean (yes/no) 
and enumerator. The latter is a finite user defined set of values. The window below shows an 
example of each type. The numeric field expects a number using the keyboard. Selecting a value 
from the dropdown menu sets the other types. I

3
S allows you to include metadata elements in the 

search process described below. 
 

 

Figure 5-1: The metadata window. 

 
The metadata fields are not fixed and can easily be edited manually. The metadata structure is 

defined in the file metadata.xml in the database directory but I
3
S provides a tool to edit the 

metadata using more easily. For more information you are referred to paragraph 4.1.3. 



I
3
S Contour Manual, v3.0 September 2011  

 
 
 
 
 

26 

 

5.2 The search process 

After selection of search from the menu or pressing the search button , a new window will appear 
as shown in Figure 5-2 (left).  
 
Only if the database type is ‘whale tail’ the part named ‘fluke parts’ will be visible. It allows you to 
search on only a single fluke or both flukes. 
 

   

Figure 5-2: Search window (left) and search results window (right). 

You can also search on specific metadata. The metadata is defined for the entire database in the file 

metadata.xml in the top of the database directory. You can select per type of field the appropriate 

constraints (e.g. equals, is less than, is greater than or don’t care). If you select the default don’t 

care, that field will not affect the search process. If one or more metadata elements do not satisfy the 

search constraints, the specific image is put at the end of the list of search results. If a metadata 
element is not available (i.e. not yet annotated) the search process will ignore this specific element 
and not exclude the image. 

 

When you click Search the Search result window appears. If the search takes more than a second a 

progress bar is shown. By clicking one of the results in the list the button Visual comparison 

becomes clickable. When clicking it a new window will appear as shown in Figure 5-3. The window 
contains four tab panes. The first shows both images together with the annotated contour and 
comments. The second and third tab pane shows the image of the unknown animal and the selected 
animal from the results list respectively. The fourth tab shows the normalized contours and 
histograms of all contours with optimal parameters concerning scaling, rotation and translation to 
have the best fit. 
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Figure 5-3: Visual comparison tab. 

 

Figure 5-4: Histogram comparison. 
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5.3 Actions after the search is completed 

Based on the information in the ‘Compare results’ window you will ultimately decide whether the 
individual is already known or unknown. You have four options how to proceed: 
1. The individual is known and because the image is of good quality you want to add it to the 

identification database as reference in future searches. 
2. The individual is new and you want to add it to the identification database in a new individual 

directory. 
3. The individual is recognized but you do not want to add it to the identification database. You only 

want to rename the image at the current location, e.g. in your own database. 
4. You do not want to undertake any action. 
 
These four options are provided in the same order by the buttons at the bottom of the window. Figure 
5-5 shows these buttons in more detail. 
 

 

Figure 5-5: The four buttons at the bottom of the window. 

5.3.1 Include in database 

Only add good quality images to the identification database. Poor quality images (e.g. large 
deviations from a perpendicular viewing angle with respect to the animal) will lead to poor quality 
search results. Ideally, aim at having about three reference images per individual in the identification 
database. When clicking on the ‘Include in database’ button the following window will appear. 
 

 

Figure 5-6: The 'Include in database' window. 

By clicking the field Rename file you can also edit the filename. The fingerprint file will get the same 

name, only with extension .fgp. We strongly advise to make sure that each filename contains the 

identification number or name of the individual. After clicking Ok both the image and the fingerprint 

file are copied (not moved) to the same directory as the matching image you selected. If you have 
renamed the file, you will be asked whether you want to rename the original file as well. 
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5.3.2 New individual 

If no matching individual was found you will probably assume it is not yet in the identification 
database. To add it to the database, click on the appropriate button. The following window will 
appear. 

 

Figure 5-7: The 'New individual in database’ window. 

Fill in the name of the individual. This can be a name like ‘Gregory’ or just a number such as 
‘Humpback 301’. This name will be the name of the new directory. In the next section you can 
choose to rename the image and fingerprint file. We strongly advise to rename the file so it 

represents the identity. For example, in case of Gregory you could name the file Gregory-

12March2009Yap.jpg. After clicking Ok both the image and the fingerprint file are copied (not 

moved) to the new directory in your identification database you just specified. If you have renamed 
the file (which you should have), you will be asked whether you want to rename the original file as 
well. 

5.3.3 Only identification 

If you have successfully identified an individual but do not want to include the image in the 

identification database, you still might want to rename the file. In this case, press Only identification 

and the following window will appear. 
 

 

Figure 5-8: The 'Only identification window'. 

Fill in the new name and make sure it ends with the proper extension (most likely .jpg) and press 

Ok next. Both image and fingerprint file will be renamed. 
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6 Some final thoughts on I
3
S 

6.1 Limitations of I3S 

Although the family of I
3
S tools has been shown to work on a large group of animals, there are some 

limitations you should consider. Below we will discuss the two most important issues. 
1. 2D vs. 3D. The main limitation is that a 2D model is used for a 3D animal. Especially with 

increasing observation angles the limitations of the 2D approach become apparent. 
Experiments on I

3
S Classic showed that accuracy deteriorates considerably with angles 

larger than 40 degrees. For the moment we therefore advise to use photos taken from a 
viewing angle smaller than 30 degrees whenever possible. This is particularly important for 
the photos (to be) included in the identification database. 
 

2. Linearity. Even in case of a 3D model, we still assume linearity of the animals. In plain 
English: we assume that the animals are rigid and their body parts are always in the same 
position with respect to each other, which is an optimal situation for comparison. 
Unfortunately, this is often not the case for e.g. the tails of humpback whales. Especially the 
flukes are often subject to deformation, which hinder proper comparison and identification.  

 

6.2 Future work 

When the database gradually increases, search time will increase as well. On standard hardware, 
the algorithm can do 15 comparisons per second. There are several options to further increase 
comparison speed, for example by using multiple cores and some fine tuning of the algorithm. 
However, it is not likely this will be implemented unless we get signals from users that this is 
necessary.  
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